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This exercise and assignment demonstrate how Excel can be used as a data calculator and to transform 
data from one format (a matrix) to another (an edge list of unique, paired data values).  Such 
transformations are often necessary to utilize different software programs.  Students will learn about 
pivot tables (actually, inverse pivot tables), putting formulas into Excel, and time saving lookup 
formulas to populate cells from other columns or worksheets.  The concepts are introduced in the 
exercise in which students are given numerous screen shots to help them accomplish the necessary 
tasks.  Afterwards, in the assignment, students are required to perform similar steps, but adjusted for 
slightly different parameters, to demonstrate that they understand the formulas and concepts being 
used.  Contact me and I will share the Excel files referenced herein. 



Note from author:
• My Excel Assignment I use for the course and 

students really seem to 
like. https://notredame.box.com/s/e7nwrbz1
xjmaqr8a4zk0iixrvvh603no (I can supply 
anyone interested with supplemental files and 
interim worksheets.)

•
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Week 3: Excel Exercise and Assignment
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Agenda
1. Housekeeping

2. Excel Exercise

3. Excel Assignment
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1.  Housekeeping



Housekeeping
• Remember, please fill out the 

voluntary student background 
survey.
– Thank you to those that already 

did!

• You are to turn in BOTH the Excel 
Exercise and Excel Assignment on 
Brightspace.

• As noted in class, you cannot 
complete all steps on a Mac.
– You can begin work on a Mac and 

go to the computer lab to do the 
steps that cannot be completed on 
a Mac.

– Alternatively, you can email me 
your file and I can help.
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Zoom Meeting Space

• Normally, I could stand over your 
shoulder, spot errors, and help you 
correct things in person.

• Given the pandemic, we will have to 
do this at a distance.

• Here is my Zoom Meeting Space 
information.
– Just email me when you need help. 
– {Zoom information redacted}
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2. Excel Exercise



Goals of Excel Exercise and Assignment

• Practice obtaining data from a Website that is 
not downloadable in an Excel formatted file.

• Practice incorporating text files into Excel 
using delimiters.

• Practice using Excel as a data calculator using 
formulas.

• Introduction to pivot tables.

• Introduction to Lookup Formulas.
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Large Scale Directions
• Exercise – Download latitude and longitude data 

for the state capitals and determine which two 
are closest and which two are furthest apart.
– Instructions will be given in a more step by step 

fashion.
– You are required to submit this as well as the 

assignment.

• Assignment – Download latitude and longitude 
data for national capitals and determine which 
two are closest and which two are furthest apart.
– Skills learned in the exercise will allow you to 

complete the assignment.
– Graded for both completion, and correct results.
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Step 1: Obtaining the Data
• Go to the following URL:  

http://www.xfront.com/us_states/

• Starting with “Name: Alabama,” copy and paste all of 
the text for all fifty states into a text file.

– I recommend using Notepad for Windows users.

– I believe the equivalent for Mac users is TextEdit. Make 
sure to save it as plain text.

– The file should be saved with .txt extension and look 
similar to the file in the resources section for this exercise: 
State_Capital.txt.

– For windows users, Notepad is a program that can be 
found by typing “Notepad” into the search box on the 
taskbar.

• If you do not know how to cut and paste, do the 
following:

– Position your cursor at the beginning of the “N” in “Name: 
Alabama”  left click, and drag the cursor to the bottom of 
the text displayed on the webpage.  (Get all 50 states.)

– Select the Copy command (ctrl+C)

– Open your text editor

– Under Edit, select Paste (ctrl+V)

– Save the file as My_State_Capital.txt

Using TextEdit on a 
Mac, before saving, 
select the Format Tab 
and select “Make Plain 
Text.” Then save. 10
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Step 2: Parsing the Data
• Note, this functionality has 

really changed over the past 
several versions of Excel. 

• I am only giving the 
screenshots and instructions 
for Excel for Office 2019 
available on campus 
computers.

• If you are unsure of which 
version of Excel you are 
using:
– In Excel, click on the “File” 

tab.

– On the left side navigation, 
click on “Account.”
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Step 2: Parsing the Data with Import Delimiters
• We next need to get the data into 

Excel in the most usable form.

• Save a new (“blank”) Excel 
Workbook using the following 
naming convention: 
(Your_Last_Name)_Excel_Exercise

• Save it to the desktop or the same 
place you saved your 
My_State_Captial.txt file (or 
whatever you called it.)

• 1. Click on the Data tab. 
• 2. On the “Get & Transform Data” 

portion of the ribbon, click on: 
“From Text/CSV”

• Select “My_State_Capital.txt” and 
click on “Import.”

12
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• 1. Click on “Edit”

• 2. In the resulting Power 
Query Editor window,  
click on Split Column 
button’s pulldown menu 
and select, “By 
Delimiter.”

Step 2: Parsing the Data with Import Delimiters

1

2
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• In the “Split Column by 
Delimiter” box leave in the 
default “Colon,” and leave the 
“Each occurrence of the 
delimiter” option selected.

• Click on O.K.

• Double Click on “Close & 
Load” to finish the data 
importation process.

• This should leave you with two 
columns—one for the meta-
data descriptor, and one for 
the content. We want the data 
in this two column format for 
reasons that we will see later.  
Note also that the colons, “:”,  
are no longer there.

Step 2: Parsing the Data with Import Delimiters
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• Your Excel Worksheet should now look like the following image.
• However, the way the data was imported left a space in front of many of the data elements in columns 1.1 & 1.2.
• In step 3, we will remove these spurious spaces as they would cause problems for us later.

• Note, I have also renamed the Worksheet from Sheet1 to Initial. To do this, right click on the Sheet2 tab at the 
bottom of the page.  Click on Rename.  Rename the Worksheet “Initial”

Step 2: Parsing the Data with Import Delimiters
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Step 3: Cleaning up the Importation Process
• To trim the extra spaces in front of the values in 

Column1.1:

– In cell C2, type “=TRIM(A2)” and hit enter. 

• The TRIM function “[r]emoves all spaces from text 
except for single spaces between words. Use 
TRIM on text that you have received from another 
application that may have irregular spacing.” 
http://office.microsoft.com/en-us/excel-
help/trim-function-HP010062581.aspx

• Excel is getting smarter and populated the 
command down the entire column.  Previously, 
one had to:

– Copy this formula down all of the column by doing 
the following:

• Click on Cell C1
• Click on “Copy”
• Left click and drag to the bottom of the column (Line 

448).
• Release the left click.

• Do the same thing for Column 1.2:
– In cell D2, type “=TRIM(B2)” and hit enter. 

• This has removed the extraneous spaces at the 
outset of the words, but preserved the space in 
two word capital names such as “Little Rock”

16
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Step 3: Cleaning up the Importation Process
• However, columns 1.3 and 1.4 now 

contain an active formula and we need 
to “flatten” these out.

– Click on the Column C header (Column 1.3) 
to select the whole Column.

– Click on Copy.

– Click on Column E header to select it.

– Under the expanded Paste options (see 
pull-down arrow), select one of the “Paste 
Values” options (the FIRST one “Paste 
Values”).

– Do the same for Column D (Column 1.4) 
pasting just values into Column F.

• Delete Columns A, B, C & D (1.1, 1.2, 
1.3, and 1.4)

• Delete Row 1 with the column Names

• Both of the two remaining columns are 
now clean of formulas.

– And it should look like the image on the 
right.
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Step 3: Cleaning up the Importation Process
• Insert a new column in front of both 

columns.

• Cut and paste the state name in front of 
all related cells.  Do this for all 50 states.
– Yes, there can be some tedium to data 

cleaning and manipulation.

– If you don’t like the tedium, you can 
always become a crack data parser using 
PYTHON.

• You can also try Google’s Open Refine.
• https://openrefine.org/

– However, I prefer to use my Microsoft 
Office tips and ticks.

• NOTE: If you want to avoid this tedium, 
and make sure you have done 
everything correctly, open and use the 
following file from now on:

– Hook_Excel_Exercise_INTERIM_1.xlsx

18
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Step 3: Cleaning up the Importation Process
• We now need to remove the extraneous 

rows.

• Click on the upper left-hand box (above 
1, and to the left of A) to select the 
entire contents of the Worksheet.

• Click the Data Tab.

• Click on Sort.

• Select “Sort By” Column B

• Delete the rows that were previously 
blanks and that do not have content in 
Column B.

• Resort by Column A, but also “Add Level” 
and also sort by Column B as a secondary 
sort at the same time to get things in the 
correct order again.

• You should now have exactly 200 rows—
four rows for each state.

– See image on the next slide. 19



Step 3: Cleaning up the Importation Process

20



Step 3: Cleaning up the Importation Process
• Cut and Paste Colum A into Sheet 1.

• Rename Sheet2, “Clean_Table”.

• On the Data Tab, Click on “Remove 
Duplicates.”
– If done correctly, you will be left with 

50 States.

• Insert a row at top to be used for 
column headers.

• Clean_Table should have the 
following four column Headers:
– State
– Capital Name
– Capital Latitude
– Capital Longitude

• The State column should already be 
populated and sorted in alphabetical 
order.

21



Step 3: Cleaning up the Importation Process

• On the “Initial” 
worksheet, select all 
cells.

• Click on the Data tab.

• Click on Sort.

• Do a two Column sort:
– First, Column B.
– Then click “Add Level”
– Then by, Column A.

22



Step 3: Cleaning up the Importation Process
• Cut and paste the data in the 50 

appropriate rows to fully populate the 
Clean_Table columns.
– Note, the States will be in the same 

order as the States column in the 
Clean_Table worksheet.

– Cut the 50 cells adjacent to “Capital 
Latitude” and put them in the correct 
cells on the Clean_Table worksheet.

– Repeat for “Capital Longitude” and 
“Capital Name.”

– Clean_Table should look like the image 
to the right.

• If you have doubts or want to make 
sure you are doing it right. See: 
Hook_Excel_Exercise_INTERIM_2.xlsx

• Also, you can spot check values in 
Clean_Table with the original website 
data to make sure the values are 
correct.
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Step 3: Cleaning up the Importation Process
• The little green triangles (IF 

THEY APPEAR) in the upper left 
corner of the cells in columns C 
& D indicate a data mismatch.
– “Number Stored as Text.”

• To correct this:
– select all affected cells (and 

only the affected cells),
– position your cursor on the 

yellow exclamation mark error 
message,

– in the resultant pulldown menu, 
click on “Convert to Number.”

• Click on the “+” symbol on the 
bottom of the screen to create 
a new worksheet.
– Rename the Sheet, “Matrix”
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Step 4: Creating the 50 x 50 Matrix
• Cut and Paste the 

50 state capital 
names
– from the 

“Clean_Table” 
worksheet (still in 
alphabetical order 
by corresponding 
state name)

– in cells C4 through 
C53 of the 
“Matrix” 
worksheet.

25



Step 4: Creating the 50 x 50 Matrix
• Select again the 50 

state capital names 
from Clean_Table.

• Place your cursor 
in cell: D3.

• Under Paste 
options, click on 
Transpose.
– (Mouse-over all of 

them until you see 
Transpose.)

• The result should 
be that cells D3 
through BA3 are 
occupied with the 
capital names.
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Step 4: Creating the 50 x 50 Matrix
• Cut and paste the 

corresponding 
Latitude data from 
“Clean_Table” into 
Column A of 
“Matrix.”
– Note: you will be 

using cells A4 
through A53.

• Repeat a Transpose 
paste to get the 
same data in row 
1, cells D1 through  
BA1.
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Step 4: Creating the 50 x 50 Matrix
• Repeat the steps 

from the previous 
slide until the 
corresponding 
Longitude data from 
“Clean_Table”

– is in column B of 
Matrix (cells B4 
through B53)

– and row 2 (cells D2 
through BA2).
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Step 5: Using Excel as a Data Calculator
• Position your cursor in cell D4.

• Cut and Paste the following formula into the formula bar:

=ACOS(COS(RADIANS(90-$A4)) *COS(RADIANS(90-D$1)) +SIN(RADIANS(90-
$A4)) *SIN(RADIANS(90-D$1)) *COS(RADIANS($B4-D$2))) *3958.756

– This formula calculates distances, by air, in miles between two points of 
latitude and longitude.

– Source: http://bluemm.blogspot.com/2007/01/excel-formula-to-calculate-
distance.html

– Note: the dollar signs “$” make sure the corresponding columns and rows 
do not change when we cut and paste the formula into adjacent cells.

• Click enter.

• The ‘######” indicate that the column width is too small to display 
the actual value.

• To remedy this, double click on the column header line to the right 
of the D in the Column D label. 29
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Step 5: Using Excel as a Data Calculator
• Cell D4 should display zero as there is no distance 

between Montgomery and itself.

• Put your cursor in cell D4.

• Click Copy.

• Click on cell D4 and drag it all the way to cell BA53

• Click Paste (regular).

• This will put the formula in all the cells of the 
matrix and update the formula for the appropriate 
cell references for each cell.

• To convince yourself of being correct so far, see this file: 
Hook_Excel_Exercise_INTERIM_3.xlsx

• And see the image on the next slide.
30



Step 5: Using Excel as a Data Calculator
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Step 6: Deleting Unneeded Cells
• Delete, the central 

diagonal in the matrix.

• These are all the cells 
in which one state 
capital corresponds 
with itself.

• As expected, these 
values are zero and 
only get in the way of 
future calculations.
– In the few instances 

when there is a very 
small number (in 
scientific notation) 
instead of zero, this is 
attributable to 
rounding errors.
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Step 6: Deleting Unneeded Cells
• Create new worksheet and 

rename it “Half-Matrix”

• Cut and paste all of the cells from 
Matrix to Half-Matrix in their 
same location.

– (But, paste special (values) so the 
formulas go away and the data is 
flattened.)

• Each half of the matrix duplicates 
the other.  The ordering of which 
city comes first is all that is 
different between top and lower 
halves.

• Therefore, delete, the lower half 
of the matrix.

• This is all content in cells below 
the central diagonal (which is now 
also gone).

• Also, delete columns A & B as well 
as rows 1 and 2 as we no longer 
need this data that we had 
previously used for our 
calculations. 33



Step 7: Matrix Superlatives
• In cell AZ52 of Half-Matrix, paste 

in the following formula:
=MIN(C2:AY50)

• This computes the lowest value 
in that cell range—34.9165 
miles.

• A Find command of the number 
34.9165 reveals that the two 
closest capital cities are Boston 
and Providence.

• In cell AZ53 of Half-Matrix, paste 
in the following formula:

=MAX(C2:AY50)

• This computes the maximum 
value in the cell range—
5109.514 miles.

• A Find command of the number 
5109.514 reveals that the two 
furthest capital cities are 
Honolulu and Augusta. 
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Step 8: Pivot Tables
• A matrix is an efficient data form for some 

purposes.

• But sometimes, we want to transform the 
relationships in the matrix to individual lines 
of data:

Honolulu Augusta 5109.5145
Boston Providence 34.91650492

• This is accomplished through the Pivot Table 
command, or in our case, a reverse pivot table 
command, in Excel.
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Step 8: Pivot Tables
• To create a reverse the 

pivot table, you need to 
open PivotTable and 
PivotChart Wizard dialog 
first and create a new pivot 
table in Excel.

• Press Alt + D + P shortcut 
keys to open PivotTable and 
PivotChart Wizard dialog.

• Select “Multiple 
consolidation ranges” 
option and the 
“PivotTable” option.

• Then click “Next.”
36

Content adapted from:
https://www.extendoffice.com/documents/exc
el/2461-excel-reverse-pivot-table.html
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Step 8: Pivot Tables
• In the next 

dialog box, 
click on “I will 
create the page 
fields option” 
and click Next.
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Step 8: Pivot Tables
• Click inside cell A1 of 

the Half-Matrix 
worksheet to activate 
it.

• type in the syntax 
displayed to the right.

– Or,

• While holding down 
the Shift key, use 
the arrow keys to 
select all of the half 
matrix content—
this will be a region 
bounded by A1 in 
one corner and 
AY51 in the adjacent 
corner.

• Click Next:
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Step 8: Pivot Tables
• Select “New 

Worksheet” 
and click Finish.
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Step 8: Pivot Tables
• For the real magic to happen, double click on cell AZ55 (the 

grand total of all of the columns and all of the rows).
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Step 8: Pivot Tables
• If done correctly, this 

process creates two 
worksheets.
1. A sheet that 

features grand 
totals
• I have renamed this 

sheet “Pivot_Table_ 
Intermediate.”

2. A sheet that 
features three 
headers: Row, 
Column, Value. 
• I have renamed this 

sheet “Individual_ 
Edges.”
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Step 9: Edge Manipulation
• Create a new worksheet called 

“Clean_Edges.”

• From the “Individual_Edges” worksheet, cut 
and paste all rows except the header row 
into a new worksheet titled “Clean_Edges”.

– You cannot delete the header row from the 
worksheet, Individual_Edges.

• In the Data tab, sort by Column C (then by 
Column A, and then by Column B—all at 
once) and delete all of those edges without 
a distance value in column C.

– You should be left with 1225 rows of data. 

• Select the header for Column C to activate 
all the content remaining in column C.

• Under the Home tab, and Format, select 
Format Cells.

• Click Number, and Decimal Places 2. 

• This will remove some of the long decimals 
from our data.

42



Step 10: Lookup Tables
• Lookup commands are an easy 

way to populate your tables with 
corresponding values from 
another table.

• For instance, we might not know 
all of the state capitals and 
would like to display the 
corresponding state name next 
to the capital name in both 
columns of our “Clean Edges” 
table.

• To do this, create a new 
worksheet, 
“Clean_Table_Rearranged”

• Copy the contents from 
“Clean_Table” into this 
worksheet.

• Reverse the columns such that 
Capital Name comes before 
State.

• See image to the right.
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Step 10: Lookup Tables
• In the Clean_Edges worksheet, 

insert a column in front of both 
columns that contain state capital 
names.

• In Cell A1, insert the following 
lookup formula:

=VLOOKUP(B1,Clean_Table_Rearranged!A
$2:B$51,2,FALSE)

A Note about the Lookup syntax.
• This formula tells the computer that 

for the value currently listed in cell B1, 
Look up its corresponding value on the 
Clean_Table_Rearranged worksheet 
bounded by the region of cells from A2 
to B51. 

• The 2 is the column number that 
contains the return value

• and False corresponds with exact 
matches as opposed to approximate 
matches (TRUE).

• https://support.microsoft.com/en-
us/office/vlookup-function-0bbc8083-
26fe-4963-8ab8-93a18ad188a1

• Copy Cell A1 all the way to the 
bottom of the column.

44
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Step 10: Lookup Tables
• In Cell C1, insert the 

following lookup formula:
=VLOOKUP(D1,Clean_Table_R
earranged!A$2:B$51,2,FALSE)

• Copy Cell C1 all the way to 
the bottom of the column.

• To check your work, consult 
my final spreadsheet:
– Hook_Excel_Exercise_FINA

L.xlsx

• Please upload your 
completed Excel Exercise 
file to Brightspace

45
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EXCEL ASSIGNMENT



Excel Assignment
• Do all of the same manipulations as above, but with 

the following data:

– National_Capital_Data_Converted (on Brightspace)

• This data was taken from: 
ttp://www.csgnetwork.com/llinfotable.html

• The good news is that all of the information on the website is 
already tabular data.  One can select all of the cell contents and 
paste into the first cell of an blank Excel Worksheet.

• In other words, one does not have to clean the data.

• Additionally, I have done the manipulations to get the latitude and 
longitude data from degrees and minutes to the decimal method 
of stating latitude and longitude. 

• Please upload your completed spreadsheets on 
Brightspace (both the Excel Exercise and Assignment).

47
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